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Introducing Microsoft Office OneNote 2007

Welcome to Microsoft® Office OneNote® 2007, a note-taking program that helps you efficiently manage your notes and information. Office OneNote 2007 is included in the 2007 release of the Microsoft Office system of programs, servers, and services for information workers.

The New World of Work

In today’s world of work, people are increasingly required to stay on top of ever-growing volumes of information, and teams are being asked to work together more than ever before. People have lacked a tool that’s flexible enough to capture the many different types of information they deal with every day, and organizations lose valuable information because it isn’t captured or because it’s lost in e-mail or stuck on paper. When tasked with working together, teams default to e-mail for information sharing and collaboration, and it’s increasingly difficult to get teams “on the same page.”
What Is OneNote?
Office OneNote 2007 is a note-taking program in the form of a digital notebook that gives you the flexibility to gather and organize your notes and information—from typed text, audio, and video to handwritten notes and drawings, graphics, and research from the Web and other applications—all in one place. Powerful search capabilities enable you to easily find information in more content formats, such as spoken words in audio and video recordings, and text in scanned documents or pictures. 
New to Office OneNote 2007 are shared notebooks, which give teams one place to gather notes, research, and information related to a project, customer, or meeting. With shared notebooks, users can contribute and share information more effectively—whether online or offline—and OneNote automatically merges and updates everyone’s changes. 
Now you can work more efficiently and find what you need more quickly by using the digital notebook capabilities Office OneNote 2007 provides for gathering, organizing, and sharing your notes and other information.
Office OneNote 2007 Features
The 2007 release of Office OneNote includes a range of enhancements that make it easier than ever to gather, find, and work together with information. You can now more quickly find the content you need, and you can easily search for information in multiple types of content. Also, Office OneNote 2007 offers stronger integration with other Microsoft Office programs, such as the Microsoft Office Outlook® messaging and collaboration client and Microsoft Office SharePoint® Server 2007, and enables closer collaboration among team members. You also now have more control over your information because Office OneNote 2007 supports multiple notebooks, which makes it possible for users to distinguish between their personal notebooks and shared team notebooks.

Features to Increase Personal Effectiveness
	Office OneNote 2007 Features
	Benefits

	Enhanced integration with Outlook
	Two-way task synchronization between OneNote and Outlook and the ability to take notes in OneNote on any Outlook item make it easy to keep track of action items and other important information. 

	Improved integration with Windows Mobile® powered devices
	Be more productive while mobile by gathering information such as voice recordings or pictures from your camera phone, taking notes, taking notes, and viewing your notes while away from your computer, all on your Windows Mobile powered device.

	Enhanced integration with Microsoft Office Communicator 
	Take notes on a Communicator conversation quickly and easily, and keep your notes in your OneNote notebook, so you can keep valuable information for easy reuse.

	Gather many types of content in OneNote
	Make more informed decisions by gathering all of your unstructured information in one place. OneNote enables you to print any electronic file to your notebook, send Web pages to OneNote from the Microsoft Internet Explorer® browser, embed Microsoft Office documents and e-mail messages in OneNote notebooks, and record audio and video.


Features for Managing Content

	Office OneNote 2007 Features
	Benefits

	Instant Search
	Find what you are looking for quickly by using Instant Search, which uses the Windows® Desktop Search engine and indexes your content in the background.

	Optical character recognition (OCR) search
	The OneNote OCR search engine reads text in scanned documents, pictures, or images, enabling you to easily find information where you couldn’t before.

	Audio search
	Save time finding relevant information by searching electronically for spoken words in audio and video recordings.

	New organization pane
	Organize your information according to your needs and keep it at your fingertips by using the new organization pane, which supports drag-and-drop functionality and hyperlinks between sections of your notebook.

	Import/export application programming interfaces (APIs)
	Reduce errors and avoid reentering the same data in multiple systems by enabling Office OneNote 2007 to connect directly to the other systems you use, such as customer relationship management (CRM) and document management systems. 


Features to Simplify Working Together

	Office OneNote 2007 Features
	Benefits

	Support for multiple notebooks 
	Multiple notebooks enable you to better organize your own information and allow you to set up shared notebooks for projects, recurring meetings, or other teamwork.

	Enhanced notebook sharing
	Shared notebooks give teams one place to collect project and team notes and other content. Team members can work simultaneously in a shared notebook, or at different times from different locations; updates happen automatically across all team members’ notebooks.

	Offline read/write access to shared notebooks
	Offline read/write access enables you to make changes to shared notebooks while offline; changes merge automatically once reconnected. Changes optimize the network, so only individual bits and bytes of information are transferred, instead of entire files.

	Ability to store shared notebooks on SharePoint sites
	Shared notebooks stored on Microsoft Windows® SharePoint® Services sites enable organizations to digitize, store, and easily search new types of content and unstructured information, making a richer set of data available for the corporate record.


Getting Started with Office OneNote 2007
Getting started with Office OneNote 2007 is as easy as opening the program and beginning to type anywhere on the page. Unlike Microsoft Office Word or other document processing programs, OneNote offers you the flexibility of typing wherever you want—as you would on paper. And, as with pen and paper, there is no Save button in OneNote—everything is automatically saved as you write it. OneNote also automatically creates backups of your notebooks.
When you first open OneNote, you will see a page like the one pictured in Figure 1. You’ll find that OneNote has a familiar appearance, because it is structured much like a paper notebook, with pages and sections for organizing. 
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Figure 1: The opening view of Office OneNote 2007. 

Anatomy of a OneNote Notebook

What are the key features of OneNote notebook pages? Let’s look at the distinction between OneNote pages and sections, which are different kinds of containers for organizing information. 
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Figure 2: The layout of a OneNote page.
Notebooks, Sections, and Pages
A OneNote notebook contains one or more sections. Sections are navigated through colored tabs on the top portion of the OneNote page. (See Figure 2.) Sections contain one or more pages. You can add an unlimited amount of pages to any OneNote section, so you’ll never run out of “paper” in your notebook. 

The sections within a notebook are much like sections in a three-ring binder. You can create as many sections as you need and customize them by naming them after different projects, types of meetings, or anything you want. For example, project managers might have a different notebook for each project, with different sections for each component of a project (such as vendor meetings, client meetings, and project timelines).

Automatic Save
A benefit of a paper notebook is its permanence; once you write something down on paper, it is always there. Office OneNote 2007 offers the same kind of convenience. There is no Save button in Office OneNote 2007—even if you turn off the computer or close the program quickly, you do not need to worry about losing important information—it is automatically saved.
Support for Multiple Notebooks
You can use Office OneNote 2007 to create multiple notebooks, so it is easier to organize your work. For example, you can organize your work by project or special topics, or by personal information or team information to share with others. When you open Office OneNote 2007, you will see two sample notebooks and a guide notebook in the left margin of the page, and you can create additional notebooks as needed. 
Gathering Your Notes and Information in OneNote

Most people don’t have a single place where they can capture all the different pieces of information that they use in the course of their work. Some information resides in e-mail messages, some is stored on Web sites, and some details might be in a file folder or on a pad of paper. Wouldn’t it be great if you could bring together in one place all the ideas, meeting notes, Web research, and everything else that you need to do your work? 
That is what Office OneNote 2007 is all about: giving you the ability to gather, organize, and integrate in one virtual notebook all the information that your work requires. 
Creating a New Notebook

You can create a new notebook by clicking File, and then clicking New Notebook on the OneNote menu bar. This action launches the New Notebook Wizard. (See Figures 3 and 4.)
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Figure 3: Create a new notebook using the New Notebook Wizard.
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Figure 4: Specify whether the notebook is for personal use or to share.

Typing Text into OneNote
When you take notes using a pen and paper, you can place your pen anywhere on the page and just start writing. Office OneNote 2007 provides the same flexibility. Click anywhere on the OneNote page surface and you can start capturing your ideas.
With Office OneNote 2007, you can easily group related matters. For example, before a meeting you might create an area for notes (a “container”) titled “agenda,” a second area titled “attendees,” and a third titled “to do,” with a table to capture action items. During the meeting, you can quickly add relevant information to any of those three areas—or click somewhere else on the page to start a completely new thought. 
Managing Containers of Content

You can even move entire note containers by clicking a container’s outline—visible when the cursor hovers over it—and dragging it elsewhere on the page. By dragging one container into another, you can combine the content from both containers into one. Similarly, by selecting some of the content of a container and dragging it away from that container’s outline, you can split one container into two. You can also cut or copy a container and paste it on another page altogether. 
If you want to work with a portion of content, you can select the blue handle that appears to the left of a note when you hover over it. By clicking and holding the left mouse button as you move the content on the page, you can easily reorganize specific notes within a note container. For precise movement of content, hold down the ALT key while dragging content on the page.
Printing Information to OneNote
Office OneNote 2007 has a print driver that allows you to print any document to OneNote, just as you would to a printer. This feature allows you to save any document as an image in your OneNote notebook, which can then be annotated. Anything that you used to print out and store in file folders can now be printed and saved directly to OneNote, enabling you to keep all of your important information at your fingertips. (See Figure 5.)
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Figure 5: Printing a document to Office OneNote 2007.
Sending Information to OneNote from Other Microsoft Office Programs

You can paste into Office OneNote 2007 virtually anything that can be captured using the standard cut-and-paste features of the Windows operating system. In addition, Office Outlook 2007 has a Send to OneNote button for calendar items, e-mail messages, and contacts, and Microsoft Office Communicator 2007 has a Take Notes button in the Communicator window. You can also paste hyperlinks to other files and Web sites into a OneNote notebook. 
Embedding Microsoft Office Files and E-Mail Messages into OneNote
In addition to the ability to cut and paste between Microsoft Office programs, you can use Office OneNote 2007 to embed files into a OneNote notebook. You can drag any file from Windows onto a OneNote page, or you can insert the file into the page via the Insert menu by clicking File.  
Gathering Web Research into OneNote 
Office OneNote 2007 is an ideal companion when conducting Web research, and it offers several features that help you manage research results more efficiently by capturing all of the Web-based information you need in one place. For example, with the Side Note feature you can drag research onto a OneNote page as you’re working in a browser. (Hint: Right-click the OneNote icon in your system tray, and click Open New Side Note, or press the Windows logo key + N on your keyboard). This allows for a digital sticky note to “float” on your screen while you conduct your research. 
Additionally, the Screen Clippings feature enables you to select portions of Web pages or other content on your screen and automatically paste them into Office OneNote 2007. (Hint: Right-click the OneNote icon in your system tray, and click Create Screen Clipping, or press the Windows logo key + S on your keyboard). 
Lastly, the Send to OneNote button in Microsoft Internet Explorer allows you to export entire Web pages to OneNote with a single mouse click. And, of course, you can just manually copy and paste. When you copy and paste information from a Web site into a OneNote page, the source URL is automatically inserted with the information, so you can click the link and quickly return to the source of the information. 

Capturing Information on Your Windows Mobile Powered Device

Office OneNote 2007 makes it easier than ever to integrate your Windows Mobile–based Smartphone or Pocket PC into your information-gathering toolset. You can copy portions of your Office OneNote 2007 notebook onto your device, so you have the information you need when you are carrying only the device. You can also capture new information on your Smartphone or Pocket PC and easily integrate it into your OneNote notebook. For example, pictures taken with the camera on your Smartphone can be integrated into your OneNote notebook, and, provided that the quality of the image is high enough, any text in the picture will become part of your OneNote searchable index. You can also use the microphone on your device to record voice notes and integrate them into your OneNote notebook. 
To use the capabilities of OneNote on your Windows Mobile powered device, connect your phone to your computer and ensure that Microsoft ActiveSync® technology is enabled. OneNote will automatically prompt you to download Microsoft Office OneNote Mobile to your device.
Inserting Images into Your Notebook
Any printable document can be inserted as a color image into your OneNote notebook. For example, you can insert a resume into OneNote prior to an interview, or insert a slide deck and speaker notes prior to a meeting with the Microsoft Office PowerPoint® presentation graphics program. By inserting the file into your notebook, you can annotate it and save both types of information in the same place. (See Figure 6.)
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Figure 6: You can insert any printable document as a color image.
Import and Export APIs
Microsoft is publishing the application programming interfaces (APIs) to Office OneNote 2007 so that partners and developers can extend the capabilities of Office OneNote 2007 even further. With these APIs exposed, developers can make it easy to import content and data directly into Office OneNote 2007 from their applications. You’ll also find that it’s easy to move information captured in Office OneNote 2007 into other programs, such as document management applications and more. The full export API provides a seamless and user-friendly direct link to other line-of-business systems you use, enabling you to avoid time-consuming and error-prone data reentry into multiple systems. 
Handwriting and Office OneNote 2007
If you have a Tablet PC or a pen input device, you can use your digital pen to take handwritten notes or draw pictures and diagrams in Office OneNote 2007. If you are using a Tablet PC, you can either convert your handwriting to text, or leave it as handwriting. The OneNote search engine treats handwriting entered on a Tablet PC the same as text. You can use the search capabilities of Office OneNote 2007 to find information entered as handwriting or text, and Office OneNote 2007 finds the entry either way. 
You can also easily mix handwriting and text on the same page. You can change the order of handwritten items in a list using drag-and-drop editing, and you can also add bullets and numbering to your handwritten notes and mark them with Note Tags. 
Next-Generation Ink Parser

While most people use Office OneNote 2007 on a desktop or portable computer, those who use OneNote on a Tablet PC will get to take advantage of the new Tablet PC ink parser. Office OneNote 2007 continuously evaluates and revisits ink input. This ongoing analysis of your inking activities provides a handwriting recognition and ink-to-text conversion experience that is more accurate and robust than ever.
Creating a Drawing in OneNote

Office OneNote 2007 offers a drawing tool so you can create drawings or diagrams on a notebook page, even if you don’t have a Tablet PC.

Office OneNote 2007 makes it easy to create simple drawings in your notebook. You can use the new collection of drawing tools to add basic shapes and lines, so you can express and capture your ideas visually. To access drawing tools, right-click in the toolbar area, and select Drawing Tools. (See Figure 7.)
You can easily create and manipulate any of the basic shapes using your keyboard and mouse. A toolbar puts all the drawing tools within easy reach. It also includes buttons that you can use to manipulate shapes easily and insert the same shape again until you instruct OneNote to insert a different shape. Because Office OneNote 2007 treats shapes as ink, you can easily erase an unwanted shape with the eraser tool.
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Figure 7: OneNote drawing tools.
Recording Audio and Video
Office OneNote 2007 takes information gathering beyond the traditional boundaries of text and graphics by enabling you to record linked audio and video notes. Audio and video notes are particularly valuable when you do not want to miss anything that someone says or does. You can also use the Search feature to quickly find specific words or phrases in the spoken words in recorded audio or video
. (See “Finding Your Information” below.) 
Recording Audio
If you have a microphone connected to or built into your computer, you can record audio by clicking Insert and then Audio Recording. This will start the audio recording and expose the toolbar so you can stop and play back the recording. Office OneNote 2007 identifies when the audio recording starts, and as you make notes on the page, it synchronizes what you have written with the audio. By doing this, Office OneNote 2007 tracks the audio that occurred at the exact moment each note was typed or written. 

Later, if you need to clarify a certain note, move your mouse cursor over the text in question. An icon of a speaker appears in the margin. Click this icon, and Office OneNote 2007 plays the audio that it recorded while you were writing that line in your notebook. The audio file is captured as a Windows Media® Player WAV file, stored in your OneNote notebook. You can also listen to the entire audio by clicking the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video Recording toolbar. If the See Playback button is selected in the Audio and Video Recording toolbar, Office OneNote 2007 highlights what you have written as the audio progresses. (See Figure 8.) If you connect your computer to your phone using an inexpensive adaptor, you can record conference calls and link your notes to that audio 
as well.
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Figure 8: Recording linked audio ensures you won't miss important items.
Recording Video

If you have a digital video camcorder or webcam attached to your computer, you can record video (and audio, if you have a microphone) by clicking Insert and then Video Recording. The same recording toolbar controls playback and stopping the recording. Office OneNote 2007 captures the time and date when the video recording starts, and it synchronizes any annotations you make with the video. If you need to clarify something you have written, you can hover your mouse cursor over the text in question, and an icon of a speaker appears. Click the icon, then Office OneNote 2007 replays the video recorded when the annotation was made. You can also replay the entire video by clicking the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video Recording toolbar. If the See Playback button is selected in the Audio and Video Recording toolbar, OneNote highlights what you have written as the video progresses.

Organizing, Finding, and Managing Your Information 
Office OneNote 2007 helps you stay in control of all your information more easily and effectively than ever before. In addition to giving you a wide variety of methods for capturing information—from recording audio and video to “printing” information to your notebook—OneNote also provides new, powerful tools to organize and manage that information. With the data you need at your fingertips, you’ll be able to stay on top of what’s important and be better prepared.
Navigation Pane and Support for Drag-and-Drop Organization
Office OneNote 2007 features a new navigation pane that makes it easy to organize and navigate the program. The navigation pane is similar in look, feel, and behavior to the new navigation pane in Office Outlook 2007, and can be collapsed or expanded according to your needs. By clicking a notebook icon, you can easily move between open notebooks. Across the top of the OneNote workspace you will still see the familiar tabs associated with notebook sections.

By clicking the arrow at the top of the navigation pane, you can expand the view to show more detail about the notebooks and embedded sections. You can click a section in a notebook and jump to that section, making navigation across multiple notebooks and sections much easier.
Office OneNote 2007 incorporates intuitive drag-and-drop capabilities, which you can use to reorganize your notebooks, sections, and pages quickly. For example, you can click and hold a section tab and then drag it to another location among the section tabs. 

Staying in Control of Your Information

Because Office OneNote 2007 supports multiple notebooks, you can determine which notebooks to share and which to keep private. You share only what you want with whom you want. 
Further, you can help protect sensitive sections of your notebook with passwords. Using Office OneNote 2007 section protection encrypts those sections. When you try to access a protected section, you will be prompted to enter your password before you can view the page contents. 

Office OneNote 2007 saves your password in memory so that you do not have to reenter it every time you go back to a section. If you leave Office OneNote 2007 for more than a specified period (the default period is 10 minutes, but you can configure this in OneNote Preferences), Office OneNote 2007 relocks protected sections, and you must enter your password to open those sections. 
Hyperlinking

Now you can insert links and jump between OneNote pages—in the same notebook or in other notebooks. In fact, you can now create hyperlinks to any location or document from within OneNote. You can also create links to OneNote pages from any other document or location. (See Figure 9.)
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Figure 9: Embedding hyperlinks in Office OneNote 2007.

Office OneNote 2007 supports links to specific portions of other documents, presentations, and Web pages. You can also insert links to individual contacts, e-mail messages, and calendar items in Office Outlook 2007, thus creating a strong web of connections between all the people, places, and events that you need in order to do your work. 
Tables
Office OneNote 2007 offers support for tables. You can paste tables from the Web or from other Microsoft Office programs, and they retain their character as tables. You can also build your own tables quickly and intuitively, just by pressing the TAB key between the columns you want to create.

For example, if you type the word “Product,” then press the TAB key, Office OneNote 2007 creates a table automatically. Type the word “Quantity,” then press the TAB key once more, and type the word “Price.” You have created a table with three columns in it. You could continue to add columns in this manner. After you have created the number of columns you need, press the ENTER key to begin a new row within the table. 

Office OneNote 2007 also makes it easy to modify and expand tables through keystrokes. Below are some commonly used keystroke shortcuts for modifying tables.
	Action
	Shortcut

	Create more lines inside the last cell of a table.
	Press ALT+ENTER.

	Insert a row at the end of the table.
	Press ENTER or TAB in the last cell.

	Insert a row anywhere in the table.
	Press CTRL+ENTER.

	Insert a row above the current row.
	Press ENTER in the beginning of the row.

	Delete a row.
	Select the row by clicking the row handle and press DELETE or BACKSPACE.

	Delete column.
	Select the column by clicking the arrow that appears at the top of the column and press DELETE or BACKSPACE.

	Swap rows.
	Select the row, click Cut (CTRL+C), then click Paste (CTRL+V) at the beginning of the row where you want to insert the cut row.

	Split a table.
	Press BACKSPACE or DELETE at the beginning of an empty row.

	Merge tables.
	Press BACKSPACE or DELETE in the empty space between two tables.


 

Finding Your Information

Instant Search makes it possible for you to search through all of the content in your OneNote notebooks, enabling you to find the information you need much faster.
With new and powerful Instant Search, you can quickly locate the information you need, whether it’s text in Web clippings, images, or scanned documents, spoken words in audio recordings, or other information across all of your OneNote notebooks. 
When you enter a keyword in the search box at the top right of the page display, Office OneNote 2007 quickly locates the information you seek—and not just on the page in front of you, but on any page in any section and in any open notebook.
 
Instant Search can search broadly across all your OneNote notebooks or you can narrow your search to particular areas of your notebook. By selecting Search In from the pull-down menu in the search box, you can specify your search to a particular section, section group, or notebook. 
You can use “NEAR” in the search expression if you want to find only those pages where your search terms are in the same paragraph. For example, the search phrase “fast NEAR search” would identify only those pages where “fast” and “search” are in the same paragraph.
Office OneNote 2007 highlights in yellow the page tabs that contain matches to your search query. (See Figure 10.) When you press ENTER or click the Next Match arrow, Office OneNote 2007 jumps quickly to the next match, across any notebook section, making it easy to search across multiple sections at the same time. 
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Figure 10: Search for a word or phrase in any OneNote notebook content.

Instant Search uses the Windows Desktop Search engine so that you have a common search experience across Windows, OneNote, and other Microsoft Office programs such as Outlook. It indexes your content automatically in the background, including automatically scanning pictures for text using the optical character recognition (OCR) engine in OneNote, enabling you to find what you’re looking for quickly.
Optical Character Recognition Search
While Office OneNote 2007 treats imported graphics and imported file printouts as images, it also includes an OCR engine that automatically scans each image for text. If the OCR engine finds text within an image, it associates that text with the image and caches the text in the search index. In this way, the content in inserted images, whether CAD files with part names, Web pages pulled from the Internet, or any other kind of printout, becomes searchable. If you insert a photograph of a business card and then prompt Office OneNote 2007 to search for the company name appearing on the business card, a link to the image of the business card appears in the search results pane. (See Figure 11.)
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Figure 11: Search for a word or phrase using optical character recognition.
Audio and Video Search

In addition to finding text in graphic images and scanned documents, Office OneNote 2007 can find spoken words within audio and video files. For example, if you record a phone conversation that includes a discussion of the Astrodome, a search for the term “Astrodome” would deliver a link to the audio file in which the Astrodome was discussed. If you click the link in the search results window, Office OneNote 2007 opens the page with the embedded audio file and begins playing the recording at the point where the Astrodome came into the discussion.
Managing Your Information

Note Tags

OneNote offers a set of Note Tags that you can use to organize and stay on top of the information in your OneNote notebook.   
For example, you can use Note Tags to prioritize and mark key items, urgent notes, or notes that require follow-up. The Note Tags Summary task pane makes it easy to manage and view all the items you have tagged with Note Tags, which can be viewed by page, by notebook section, or across all notebook sections. (See Figure 12.)
Clicking a tagged note in the Note Tags Summary task pane takes you to that note in your notebook sections. In this way, you can navigate through notes according to the tags. For example, you could customize a Note Tag as a “supervisor” tag and, after a meeting, call up all the action items your supervisor had mentioned. Using the Note Tags Summary, you can see in an instant all of your to-do’s and assigned action items across all of your notebooks. 
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Figure 12: You can keep track of all important notes and “To Do” items in one place in OneNote.

Syncing Tasks with Office Outlook 2007 and 2003
Office OneNote 2007 offers two-way task synchronization with Office Outlook 2007 and 2003. For example, you can synchronize flagged tasks between OneNote and Outlook, so an item flagged as a task in Office OneNote 2007 automatically appears as a task in Office Outlook 2007 (and vice versa). Once a task has been checked off as complete in Outlook, the flag will turn into a check mark within OneNote. 
Also, you can link meeting notes to appointments in your Outlook calendar, or you can link OneNote notes about customers to their items in your Outlook contact list. Later, if you need to find information about the meeting on your calendar or contact details associated with that customer, you can either click the link in Office OneNote 2007, or click the link in your calendar or contacts list in Office Outlook 2007 to access the information saved in OneNote. Similarly, you can send entire e-mail messages to OneNote with the click of a button in Outlook—just look for the small OneNote icon.

Exporting Content to Other Microsoft Office Programs
Office OneNote 2007 enables you to move notebook content to other Microsoft Office programs. For example, you can select a notebook page and send it to Office Word 2007 by clicking File, and then clicking Send Page To on the menu bar. 
Support for Multiple Computers

You can now maintain the same notebook on multiple computers. This is useful when you have:

· A desktop computer and a portable computer.
· Several computers at home connected to the same home network.
· A home portable computer and a work computer (if you can connect your home portable computer to your network at work).
Office OneNote 2007 automatically synchronizes the changes among your computers when you are online, even if you made the changes while you were not connected.

To open a notebook on multiple computers, all you need to do is put it in a location that each computer can access. When you create a new notebook, pick the option “I will use it on multiple computers” in the New Notebook Wizard, and OneNote will guide you through the process. (See Figure 13.)
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 Figure 13: Select multiple computers with the New Notebook Wizard.
To see whether your notebook is up-to-date, check the up to date button on the toolbar, or click File, and then click Sync. You can click the button to check the status of each individual notebook.
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Working Together More Effectively

Shared Notebooks
Office OneNote 2007 has extended the concept of sharing beyond the real-time sharing sessions delivered in Office OneNote 2003. Using Office OneNote 2007 and a SharePoint site or a standard file server, you can share entire notebooks that multiple users can work in together at the same time or at different times. 
A team’s shared OneNote notebook can contain a wide variety of content to help people work more efficiently, including:

· Meeting or project notes

· Project brainstorming ideas

· Any supporting materials collected by team members

· Lists of action items 
· Drafts of project reports that team members can annotate 
· Project plans

· Web research and more
Shared notebooks are easy to use and enable you to work with other people in the same notebook at the same time—“check out” or “check in” is not required—and OneNote seamlessly merges everyone’s changes. On the rare occasions when two people make changes to the same text container at the same time, OneNote displays an alert that synchronization failed and produces both versions for you to view.

Create a Shared Notebook

You can easily create a shared notebook by following these simple steps:

1 On the File menu, click Share.
2 Click Create Shared Notebook. (See Figure 14.)
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Figure 14: Create a shared notebook.
3 A wizard will open and prompt you through the remaining steps.

Invite Others to a Shared Notebook
Office OneNote 2007 makes it easy to invite other people to join a shared notebook. OneNote creates an e-mail message that you can use to invite participants. (See Figure 15.) By clicking the link in the body of the e-mail message, the people you have invited can join the shared notebook.
 
[image: image18.png]Fabrikam Design Team

Invitation to Onefiate noteback Fabrikam Design Noteboak

Click here to open the notebook in OneNote:
Eabrikam Design Notebook

frthis link is disabled, start OneNote, click File | Open | Notebook, and then paste the following path into the Folder name field:
\fabrikam-svriSharedNotebooks\Fabrikam Design Notebook

If OneNote isnit installed on this computer, you can download a free trial version from:
hitp:/fwwnw. microsoft.com/office/onenate/prodinfoftrial mspx





Figure 15: Sharing notes is easy with Office OneNote 2007.

Offline Access and Synchronization
Team members can work on the shared notebook on their computers even when they are offline. As soon as they regain network access, OneNote reconciles the local copies of the notebook with the master copy saved on the server, and merges any changes into each copy of the shared notebook. This helps ensure that all members of the team have a current copy of the notebook—regardless of where they are, or when the new content was added. Everyone remains on the same page.  

 Where to Put Shared Notebooks 

A OneNote notebook can be shared by storing it in a location where others can also open it, such as a folder share on your own computer, a file server, or a SharePoint site (using Windows SharePoint Services 2.0 or later). Office OneNote 2007 will guide you through setting up a proper location if you use the Share menu or the shared notebook option in the New Notebook Wizard.
Storing Shared Notebooks on SharePoint Sites
Office OneNote 2007 provides an easy way to bring new types of valuable content into a company’s long-term content repository, and SharePoint technology and services increases the security and value of OneNote notebooks. The content within OneNote notebooks stored on a SharePoint site can be exposed to the index, making it available via SharePoint search. This makes new types of content available to the organization, such as indexed images and audio and video recordings. 
Live Sharing Sessions in Office OneNote 2007

Another sharing option in Office OneNote 2007 is Live Sharing Session. This capability enables you to share single or multiple pages of notes with other users in real time. Live Sharing Sessions use peer-to-peer technology, so no server infrastructure is required. They are also easy to use and can be set up with just a few clicks of the mouse. You can create or join a Live Sharing Session by using the Live Sharing Session option on the Share menu.
The advantage of Live Sharing Sessions is that no server infrastructure is required and you can share your notes and information with others in real time. The disadvantage is that when you terminate a Live Sharing Session, you are no longer sharing your notes with others. Changes you make while outside of a Live Sharing Session do not get updated on other users’ computers. In this regard, we recommend using Shared Notebooks instead of Live Sharing Sessions when possible.
Other Ways to Share

Sharing Notes Using E-Mail
By clicking the e-mail icon on the standard toolbar (or by using the E-Mail Recipient option from the Send Page To command on the File menu), Office OneNote 2007 users working with Office Outlook 2003 or later can share their note pages with others. Office OneNote 2007 creates a special file consisting of copies of your selected pages and attaches the file to the message. It also automatically formats the information on the page (including handwriting and graphics
) as HTML code and puts it in the body of the e-mail message, so even recipients who do not have Office OneNote 2007 can read the information. 
If a page has linked audio or video files, Office OneNote 2007 also attaches a copy of these to the message if you have elected to do this by clicking Options on the Tools menu. Similarly, any other files embedded in your notes (for example, Word documents, Microsoft Office Excel® worksheets, and PowerPoint presentations) are also attached to the e-mail message. E-mail message recipients who have OneNote can double-click the attachment and add that page to their own notebooks in a special section called Recent Opened Sections. 

If you are using an older version of Outlook or are using other e-mail programs, you can still send OneNote notes to other e-mail recipients by manually attaching the file containing the selected pages to the message. Neither older versions of Outlook nor other e-mail programs convert the notes on the Office OneNote 2007 page to HTML for inclusion in the body of the message, but you can still copy and paste your notes into your e-mail program.

Publish Notes to a Web Site or to a SharePoint Site
You can easily share information with others in a read-only form, by publishing your notes in single-file Web page form that others can view with a Web browser or open and edit in Office Word 2007. Using the Publish as PDF or XPS option on the File menu, you can create a copy of your OneNote page in a variety of formats, including a PDF file, a single-file Web page, a separate OneNote section, or a Word document
. You can post the published file on a file share, Web site, or SharePoint site. You can even send the files to others as an e-mail attachment. Office OneNote 2007 converts handwriting and drawings into pictures when it publishes the page in HTML format.
Export API
A full export application programming interface (API) provides a user-friendly link to business systems. You can reduce errors and avoid entering the same data in multiple systems by connecting Office OneNote 2007 directly to the other systems you use.
Summary

In today’s world of work, people need tools to help them work more efficiently to increase their impact and work more effectively with others. 
Gather Everything in One Place 
You can use Office OneNote 2007 to manage the overabundance of information more efficiently by consolidating all the information you need to do your job in one place.
Find Information Quickly 
You can save time finding information because all of your information is in one place and organized the way you want. You can organize your note pages any way you want and save time finding information thanks to the powerful keyword search feature.

Work Together More Effectively 
Office OneNote 2007 makes it easy to be on the same page with your colleagues by sharing some or all of your notebooks. You can improve team productivity because notebooks and information are readily accessible and easy to share. You can help your team members to be better prepared, make more informed decisions, and save time by centralizing all of your group’s information. 
By consolidating all the information you and your team need to do your job, Office OneNote 2007 enables you to work more efficiently and deliver better results.

Resources

For more information about Office OneNote 2007 and the 2007 Microsoft Office system, please visit http://www.microsoft.com/office/onenote.

System Requirements

For complete system requirements, visit http://www.microsoft.com/office/onenote.
This document is developed prior to the product’s release to manufacturing, and as such, we cannot guarantee that all details included herein will be exactly as what is found in the shipping product. The information contained in this document represents the current view of Microsoft Corporation on the issues discussed as of the date of publication. Because Microsoft must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Microsoft, and Microsoft cannot guarantee the accuracy of any information presented after the date of publication. The information represents the product at the time this document was printed and should be used for planning purposes only. Information is subject to change at any time without prior notice.
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� This feature is available in English, French, German, Spanish, Japanese, Korean, Chinese Traditional, and Chinese Simplified.





� The OneNote Find feature does not search sections or folders you have archived with the Close command on the File menu. 


� Requires Office Outlook 2003 or later.





� Handwriting and drawings in the notes are converted into picture files in the body of the e-mail message, but they retain their characteristics as handwriting and drawings in the attached ONE file.


� You can save as a PDF or XPS file from a 2007 Microsoft Office system program only after you install an add-in. For more information, see � HYPERLINK "http://r.office.microsoft.com/r/rlidOOPDFXPSAddin?clid=1033" ��Install and use a PDF or XPS add-in�.
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